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using this
manual

This user manual has been specially designed to
guide you through the functions and features of your

mobile phone. To get started quickly,
refer to “introducing your mobile phone,”

“assembling and preparing your mobile phone,”
and “using basic functions.”

Instructional icons
Before you start, familiarise yourself with the icons 
you will see in this manual: 

Warning—situations that could cause 
injury to yourself or others

Caution—situations that could cause 
damage to your phone or other equipment

Note—notes, usage tips, or additional 
information 

 Refer to—pages with related information; 
for example:  p.12 (represents “see page 
12”)
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Copyright information
Rights to all technologies and products that 
comprise this device are the property of their 
respective owners:

• Bluetooth® is a registered trademark of the 
Bluetooth SIG, Inc. worldwide—Bluetooth QD 
ID: B0xxxxx.

• Java™ is a trademark of Sun Microsystems, Inc.
• Windows Media Player® is registered trademark 

of Microsoft Corporation.

→ Followed by—the order of options or 
menus you must select to perform a step; 
for example: Press the Confirm key→ 
Messages → Create message 
(represents the Confirm key, followed by 
Messages, followed by Create message)

[ ] Square brackets—phone keys; for 
example: [ ] (represents the Power/ 
Menu exit key)

< > Angled brackets—softkeys that control 
different functions at each screen; for 
example: <OK> (represents the OK 
softkey)
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introducing your
mobile phone

 In this section, learn about your mobile phone’s
layout, keys, display, and icons.

Unpack
Check your product box for the following items:

• Mobile phone
• Battery
• Travel adapter (charger)
• Battery cover remover
• User manual 

The items supplied with your phone may vary 
depending on the software and accessories 
available in your region or offered by your 
service provider.
You can obtain additional accessories from 
your local Samsung dealer.
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Phone layout
The front of your phone includes the following keys 
and features:

The rear of your phone includes the following keys 
and features:

Power/Menu 
exit key

Alphanumeric 
keys

Volume key

Dial key

Left softkey

4-way 
navigation key

Right softkey

Earpiece

Display

Flashbulb

Mouthpiece

Camera lens 
for video calls

Confirm key

Special function 
keys

Multifunction jack

You can lock the keys to prevent any unwanted 
phone operations from accidentally pressing 
any of the keys. In Idle mode, press and hold 
[ ]. To unlock the keys, press and hold [ ].

Music/Video
call key

Flash key

Battery cover

Internal antenna

Speaker
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introducing your m
obile phone

Maintain your water and dust resistant 
feature
Your phone is resistant to water and dust when all 
compartments are closed tightly. Your phone is not 
waterproof, so follow these tips carefully to prevent 
damage to your phone.

Keys• Do not immerse the phone in 
water or use it in the rain.

• Do not expose the phone to salt 
water or ionised water, or to high 
water pressure.

• If the phone gets wet, dry it 
thoroughly with a clean soft cloth.

• Make sure that the multifunction 
jack cover is closed tightly.

• Always keep the multifunction jack 
cover clean and be careful to 
avoid damaging it.

Key Function

Softkeys Perform actions indicated at the 
bottom of the display

4-way 
navigation

In Idle mode, access user-defined 
menus; In Menu mode, scroll 
through menu options
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Confirm

In Idle mode, access Menu mode; 
In Menu mode, select the 
highlighted menu option or confirm 
an input

Dial
Make or answer a call; In Idle 
mode, retrieve recently dialled, 
missed, or received numbers

Power/
Menu exit

Turn the phone on and off (press 
and hold); End a call; In Menu 
mode, cancel input and return to 
Idle mode

Alpha-
numeric

Enter numbers, letters and special 
characters; In Idle mode, press 
and hold [1] to access voice mails 
and [0] to enter an international call 
prefix

Key Function

Special 
function

Enter special characters or perform 
special functions; In Idle mode, 
press and hold [ ] for the Silent 
profile; In Idle mode, press and 
hold [ ] to lock the keys; From the 
dialling screen, press and hold [ ] 
to enter a pause between 
numbers

Volume Adjust the phone’s volume

Flash Turn the flash on or off (press and 
hold)

Music/Video 
call

In Idle mode, launch the music 
player or make a video call, 
depending on the Music key 
setting (press and hold)

Key Function
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introducing your m
obile phone

Display
Your phone’s main display consists of three areas:

Icons
Learn about the icons that appear on your display.

Icon line
Displays various icons

Text and graphic area
Displays messages, 
instructions, and 
information you enter

Softkey line
Displays the current actions 
assigned to each softkey

Select  Back

Icon Definition

Signal strength

SOS message feature activated

GPRS network connected

Transferring data in GPRS network

EDGE network connected

Transferring data via EDGE network

UMTS network connected

Transferring data via UMTS network

Voice call in progress

Video call in progress
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Bluetooth hands-free car kit or headset 
connected

Music playback in progress

Music playback paused

Music playback stopped

FM radio on

FM radio suspended

Bluetooth activated

Connected with PC

Alarm activated

Memory card inserted

PC networking using the phone as a modem 
device

Icon Definition

Connecting to secured web page

Call diverting activated

Roaming (outside of normal service area)

Normal profile activated

Silent profile activated

New text message (SMS)

New multimedia message (MMS)

New email message

New voice mail message

New push message

New configuration message

Text message full

Icon Definition
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obile phone

Multimedia message full

Email message full

Voice mail message full

Push message full

Configuration message full

Battery power level

Icon Definition
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assembling and
preparing your
mobile phone

 Get started by assembling and setting up
 your mobile phone for its first use.

Install the SIM or USIM card and 
battery
When you subscribe to a cellular service, you will 
receive a Subscriber Identity Module, or SIM card, 
with subscription details, such as your personal 
identification number (PIN) and optional services. To 
use UMTS services, you can purchase a Universal 
Subscriber Identity Module (USIM) card.

To install the SIM or USIM card and battery,

1. Slide the latch.

If the phone is on, press and hold [ ] to turn 
it off.
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bling and preparing your m
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2. Remove the battery cover.

3. Insert the SIM or USIM card.

4. Insert the battery.

5. Replace the battery cover.

Do not use your fingernails to remove the 
battery cover. Use the supplied battery cover 
remover or a coin, instead.

Place the SIM or USIM card in the phone with 
the gold-coloured contacts facing down.
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Charge the battery
Before using the phone for the first time, you must 
charge the battery.

1. Open the cover to the multifunction jack and plug 
the small end of the travel adapter.

2. Plug the large end of the travel adapter into a 
power outlet.

3. When the battery is fully charged (the  icon is 
no longer moving), unplug the travel adapter from 
the power outlet.

4. Unplug the travel adapter from the phone.

5. Close the cover to the multifunction jack.

Push the latch completely to secure the battery 
cover. The battery cover must be closed tightly 
to avoid water damage.

With the triangle
facing up

Improperly connecting the travel adapter can 
cause serious damage to the phone. Any 
damages by misuse are not covered by the 
warranty.

Push the cover completely to secure the 
multifunction jack. The multifunction jack must 
be closed tightly to avoid water damage.
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Insert a memory card (optional)
To store additional multimedia files, you must insert a 
memory card. Your phone accepts microSD™ 
memory cards up to 8 GB (depending on memory 
card manufacturer and type).

1. Remove the battery cover.

2. Unlock the memory card cover.

3. Lift the memory card cover and insert a memory 
card with the label side facing up.

4. Close and lock the memory card cover.

About the low battery indicator
When your battery is low, the phone will emit a 
warning tone and a low battery message. The 
battery icon will also be empty and blinking. If 
the battery level becomes too low, the phone 
will automatically power off. Recharge your 
battery to continue using your phone.



21

using basic
functions

 Learn how to perform basic operations and use the
main features of your mobile phone.

Turn your phone on and off
To turn your phone on,

1. Press and hold [ ]. 

2. Enter your PIN and press <Confirm> 
(if necessary).

To turn your phone off, repeat step 1 above.

Switch to the Offline profile
By switching to the Offline profile, you can use your 
phone’s non-network services in areas where 
wireless devices are prohibited, such as aeroplane 
and hospitals.

To switch to the Offline profile, press the Confirm key 
→ Settings → Phone profiles → Offline.

Follow all posted warnings and directions from 
official personnel when in areas where wireless 
devices are prohibited.
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using basic functions

Access menus
To access your phone’s menus,

1. Press the Confirm key to access Menu mode.

2. Use the navigation key to scroll to a menu or 
option.

3. Press <Select>, <Confirm>, or the Confirm key 
to confirm the highlighted option.

4. Press <Back> to move up one level; Press [ ] 
to return to Idle mode.

Customise your phone
Get more from your phone by customising it to 
match your preferences.

Adjust the volume of the key tones
In Idle mode, press [ / ] to adjust the key tone 
volume.

Switch to or from the Silent profile
In Idle mode, press and hold [ ] to silence or 
unsilence your phone.

Change your ringtone
1. In Idle mode, press the Confirm key → Settings 

→ Phone profiles.

2. Scroll to the profile you are using.

3. Press <Options> → Edit → Voice call ringtone 
or Video call ringtone.

4. Scroll left or right to a memory location 
(if necessary).

5. Select a ringtone category → a ringtone → 
<Select>.

6. Press <Options> → Save.
To switch to another profile, select it from the list.
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using basic functions
Select a wallpaper (Idle mode)
1. In Idle mode, press the Confirm key → Settings 

→ Display and light settings → Homescreen.

2. Scroll left or right to Image and press the 
Confirm key.

3. Select an image category → an image.

4. Press <Select>.

Select a theme for the display (Idle 
mode)
To create a theme,

1. In Idle mode, press the Confirm key → Settings 
→ Display and light settings → My theme → 
Create theme (Easy) or Create theme 
(Expert).

2. Customise the theme as desired by following the 
screen.

3. When you are finished, enter a name for the 
theme and press <Save>.

4. Press <Yes> to apply the theme.

After you have created a theme,

1. In Idle mode, press the Confirm key → Settings 
→ Display and light settings → My theme → 
Select theme.

2. Select a theme and press <Save>.

3. Press <Yes> to apply the theme.

If you select the same colour for the entire 
theme, you may not be able to recognise the 
display.
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using basic functions

Set menu shortcuts
1. In Idle mode, press the Confirm key → Settings 

→ Phone settings → Shortcuts.

2. Select a key to use as a shortcut.

3. Select a menu to assign to the shortcut key.

Lock your phone
1. In Idle mode, press the Confirm key → Settings 

→ Security → Phone lock.

2. Select On.

3. Enter a new 4- to 8-digit password and press 
<Confirm>.

4. Enter the new password again and press 
<Confirm>. 

Use basic call functions
Learn to make or answer calls and use basic call 
functions.

Make a call
1. In Idle mode, enter an area code and a phone 

number.

2. Press [ ] to dial the number.
For a video call, press [ ].

3. To end the call, press [ ]. 

Answer a call
1. When a call comes in, press [ ].

For a video call, press [ ] → <Show me>.

2. To end the call, press [ ].
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Adjust the volume
To adjust the volume during a call, press [ / ].

Use the speakerphone feature
1. During a call, press <Options> → Speaker on 

to activate the speaker.

2. To switch back to the earpiece, press 
<Options> → Normal.

Use the headset
By plugging the supplied headset into the 
multifunction jack, you can make and answer calls:

• To redial the last call, press the headset button, 
and then press again and hold.

• To answer a call, press the headset button.
• To end a call, press the headset button.

Send and view messages
Learn to send or view text (SMS), multimedia (MMS), 
or email messages.

Send a text or multimedia message
1. In Idle mode, press the Confirm key → 

Messages → Create message → Message.

2. Enter a destination number and scroll down.

3. Enter your message text.  p. 26
For sending as a text message, skip to step 7.
For attaching multimedia, continue with step 4.

4. Press <Options> → Add multimedia and add 
an item.

5. Press <Options> → Advanced → Add subject.

6. Enter a subject.

7. Press the Confirm key to send the message.
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using basic functions

Send an email
1. In Idle mode, press the Confirm key → 

Messages → Create message → Email.

2. Enter an email address and scroll down.

3. Enter a subject and scroll down.

4. Enter your email text.

5. Press <Options> → Attach multimedia or 
Attach organiser and attach a file (if necessary).

6. Press the Confirm key to send the email.

Enter text
When entering text, you can change the text input 
mode:

• Press and hold [ ] to switch between T9 and 
ABC modes.

• Press [ ] to change case or switch to Number 
mode.

• Press and hold [ ] to switch to Symbol mode.
Enter text in one of the following modes:

Mode Function

ABC
Press the appropriate alphanumeric key until 
the character you want appears on the 
display.

T9

1. Press the appropriate alphanumeric keys 
to enter an entire word.

2. When the word displays correctly, press 
[ ] to insert a space. If the correct word 
does not display, press [0] to select an 
alternate word.

Number Press the appropriate alphanumeric key to 
enter a number.

Symbol Press the appropriate alphanumeric key to 
select a symbol.
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View text or multimedia messages
1. In Idle mode, press the Confirm key → 

Messages → Inbox.

2. Select a text or multimedia message.

View an email
1. In Idle mode, press the Confirm key → 

Messages → Email inbox.

2. Press <Options> → Download.

3. Select an email or a header.

4. If you selected a header, press <Options> → 
Retrieve to view the body of the email.

Add and find contacts
Learn the basics of using the Phonebook feature.

Add a new contact
1. In Idle mode, enter a phone number and press 

<Options>.

2. Select Add to Phonebook → a memory location 
(phone or SIM) → New. 

3. Select a number type (if necessary).

4. Enter contact information.

5. Press the Confirm key, or press <Options> → 
Save to add the contact to memory.
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using basic functions

Find a contact
1. In Idle mode, press the Confirm key → 

Phonebook.

2. Enter the first few letters of the name you want to 
find.

3. Select the contact’s name from the search list.

Listen to music
Learn how to listen to music via the music player or 
FM radio.

Listen to the FM radio
1. Plug the supplied headset into the phone’s 

multifunction jack.

2. In Idle mode, press the Confirm key → FM radio.

3. Press the Confirm key to start the radio.

4. Press <Yes> to start automatic tuning.
The radio scans and saves available stations 
automatically. 

5. Scroll left or right to a radio station.

6. To turn off the FM radio, press the Confirm key.

Once you have found a contact, you can:
• call the contact by pressing [ ]
• edit the contact information by pressing 

<Options> → Edit

The first time you access the FM radio, you 
will be prompted to start automatic tuning.
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Listen to music files
Start by transferring files to your phone or memory 
card:

• Download from the wireless web.  p. 30
• Download from a PC with the optional Samsung 

PC Studio.  p. 36
• Receive via Bluetooth.  p. 40
• Copy to your memory card.  p. 36
• Synchronise with Windows Media Player 11. 

 p. 37
After transferring music files to your phone or 
memory card,

1. In Idle mode, press the Confirm key → Music 
player.

2. Select a music category → a music file.

3. Control playback using the following keys:

Key Function

Confirm Pause or resume playback

Volume Adjust the volume up or down

Navigation

• Left: Restart playback; Skip 
backward (press within 3 
seconds); Scan backward in a file 
(press and hold)

• Right: Skip forward; Scan forward 
in a file (press and hold)

• Up: Open the playlist
• Down: Stop playback
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Browse the web
Learn to access and bookmark your favourite web 
pages.

Browse web pages
1. In Idle mode, press the Confirm key → 

Applications → Browser → Home to launch 
your service provider’s homepage.

2. Navigate web pages using the following keys:

Bookmark your favourite web pages
1. In Idle mode, press the Confirm key → 

Applications → Browser → Bookmarks.

2. Press <Options> → Add bookmark.

3. Enter a page title and a web address (URL).

4. Press <Save>.

Key Function

Navigation Scroll up or down on a web page

Confirm Select an item

<Back> Return to the previous page

<Options> Access a list of browser options
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using advanced
functions

 Learn how to perform advanced operations and use
additional features of your mobile phone.

Use advanced call functions
Learn about your phone’s additional calling 
capabilities. 

View and dial missed calls
Your phone will display calls you have missed on the 
display. To dial the number of a missed call,

1. Press <View>.

2. Scroll to the missed call you want to dial.

3. Press [ ] to dial.

Call a recently dialled number
1. In Idle mode, press [ ] to display a list of 

recent numbers.

2. Scroll to the number you want and press [ ] to 
dial.
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Hold a call or retrieve a held call
Press <Hold> to place a call on hold or press 
<Retrieve> to retrieve a held call.

Dial a second call
If your network supports this function, you can dial 
another number during a call:

1. Press <Hold> to place the first call on hold.

2. Enter the second number to dial and press [ ].

3. Press <Swap> to switch between the two calls.

4. To end the call on hold, press <Options> → End 
→ Held call.

5. To end the current call, press [ ].

Answer a second call
If your network supports this function, you can 
answer a second incoming call:

1. Press [ ] to answer the second call.
The first call is automatically placed on hold.

2. Press <Swap> to switch between the calls.

Make a multiparty call (conference call)
1. Call the first party you want to add to the 

multiparty call.

2. While connected to the first party, call the 
second party.
The first party is automatically placed on hold.

3. When connected to the second party, press 
<Options> → Conference call.
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4. Repeat steps 2 and 3 to add more parties 

(if necessary).

5. To end the multiparty call, press [ ].

Call an international number
1. In Idle mode, press and hold [0] to insert the + 

character.

2. Enter the complete number you want to dial 
(country code, area code, and phone number), 
and then press [ ] to dial. 

Call a contact from Phonebook
You can call numbers directly from Phonebook using 
stored contacts.  p. 27

1. In Idle mode, press the Confirm key → 
Phonebook.

2. Scroll to the number you want to dial and press 
[ ] to dial.

Use advanced Phonebook functions
Learn to create namecards, set speed dial numbers, 
and create groups of contacts.

Create a namecard
1. In Idle mode, press the Confirm key → 

Phonebook.

2. Press <Options> → My name card.

3. Enter your personal details.

4. Press the Confirm key or press <Options> → 
Save.

You can send your namecard by attaching it to 
a message or email or transferring it via the 
Bluetooth wireless feature.
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Set speed dial numbers
1. In Idle mode, press the Confirm key → 

Phonebook.

2. Scroll to a contact to assign.

3. Press <Options> → Assign speed dial.

4. Scroll to a number you want to set (2-9) and 
press <Select>.
The contact is saved to the speed dial number.

Create a group of contacts
By creating groups of contacts, you can assign 
ringtones and caller ID photos to each group or send 
messages and emails to an entire group. Start by 
creating a group:

1. In Idle mode, press the Confirm key → 
Phonebook.

2. Scroll left or right to Groups.

3. Press <Options> → Create group → a memory 
location (if necessary).

4. Enter a group name and press <Save>.

5. Press <Options> → Group settings.

6. To set the caller ID image, press the Confirm key 
→ an image category → an image.

You can now call this contact from Idle mode 
by pressing and holding the assigned speed 
dial number.
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7. To set a group ringtone, scroll down and press 

the Confirm key → a ringtone category → a 
ringtone.

8. Press <Options> → Save.

Use advanced messaging functions
Learn to create templates and use templates to 
create new messages.

Create a text template
1. In Idle mode, press the Confirm key → 

Messages → Templates → Text templates.

2. Press <Create> to open a new template 
window.

3. Enter your text and press the Confirm key to save 
the template.

Create a multimedia template
1. In Idle mode, press the Confirm key → 

Messages → Templates → Multimedia 
templates.

2. Press <Create> to open a new template 
window.

3. Create a multimedia message, with a subject 
and desired attachments, to use as your 
template.  p. 25

4. Press the Confirm key to save the template.

Insert text templates in new messages
1. To start a new message, press the Confirm key 

→ Messages → Create message → a message 
type.

2. Scroll down to the text field, and press 
<Options> → Insert → Text template → a 
template.



36

using advanced functions

Create a message from a multimedia 
template
1. In Idle mode, press the Confirm key → 

Messages → Templates → Multimedia 
templates.

2. Scroll to the template you want and press 
<Options> → Send.
Your template opens as a new multimedia 
message.

Use advanced music functions
Learn to prepare music files, create playlists, and 
store radio stations.

Copy music files via Samsung PC Studio
1. In Idle mode, press the Confirm key → Settings 

→ Phone settings → PC connections → 
Samsung PC studio.

2. Press [ ] to return to Idle mode.

3. Using an optional PC data cable, connect the 
multifunction jack on your phone to a PC.

4. Run Samsung PC Studio and copy files from the 
PC to the phone.
Refer to the Samsung PC Studio help for more 
information.

Copy music file to a memory card
1. Insert a memory card.

2. In Idle mode, press the Confirm key → Settings 
→ Phone settings → PC connections → Mass 
storage.

3. Press [ ] to return to Idle mode.

4. Using an optional PC data cable, connect the 
multifunction jack on your phone to a PC.
When connected, a pop-up window will appear 
on the PC.
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5. Select Open folder to view files in the pop-up 

window on the PC.

6. Copy files from the PC to the memory card. 

Synchronise your phone with Windows 
Media Player
1. In Idle mode, press the Confirm key → Settings 

→ Phone settings → PC connections → 
Media player.

2. Press [ ] to return to Idle mode.

3. Using an optional PC data cable, connect the 
multifunction jack on your phone to a PC with 
Windows Media Player installed.
When connected, a pop-up window will appear 
on the PC.

4. Select Sync digital media files to this device in 
the pop-up window on the PC.

5. Edit or enter your phone’s name in the pop-up 
window (if necessary), and then click Finish.

6. Select and drag the music files you want to the 
sync list. 

7. Click Start Sync.

Create a playlist
1. In Idle mode, press the Confirm key → Music 

player → Playlists.

2. Press <Options> → Create playlist.

3. Enter a title for your new playlist and press 
<Save>.

4. Select the new playlist.

5. Press <Options> → Add → Tracks.

6. Select the files you want to include and press 
<OK>.
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Store radio stations automatically
1. Plug the supplied headset into the phone’s 

multifunction jack.

2. In Idle mode, press the Confirm key → FM radio.

3. Press the Confirm key to start the radio.

4. Press <Options> → Self-tuning.

5. Press <Yes> to confirm.
The radio scans and saves available stations 
automatically.
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using tools and
applications

 Learn how to work with your mobile phone’s tools
and additional applications.

Use the Bluetooth wireless feature
Learn about your phone’s ability to connect to other 
wireless devices for exchanging data and using 
hands-free features.

Turn on the Bluetooth wireless feature
1. In Idle mode, press the Confirm key → 

Applications → Bluetooth.

2. Press <Options> → Settings.

3. Scroll down to Activation.

4. Scroll left or right to On.

5. To allow other devices to locate your phone, 
scroll down to My phone’s visibility and scroll 
left or right to On.

6. Press <Save>.
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Find and pair with other Bluetooth-
enabled devices
1. In Idle mode, press the Confirm key → 

Applications → Bluetooth → Search for new 
devices.

2. Scroll to a device and press <Select>.

3. Enter a PIN for the Bluetooth wireless feature or 
the other device’s Bluetooth PIN, if it has one, 
and press <OK>.
When the owner of the other device enters the 
same code or accepts the connection, pairing is 
complete.

Send data using the Bluetooth wireless 
feature
1. Select the file or item from one of your phone’s 

applications that you want to send.

2. Press <Options> → Send name card via, 
Send via, or Send URL via → Bluetooth (when 
sending contact data, specify which data to 
send).

Receive data using the Bluetooth 
wireless feature
1. Enter the PIN for the Bluetooth wireless feature 

and press <OK> (if necessary).

2. Press <Yes> to confirm that you are willing to 
receive data from the device (if necessary).
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Activate and send an SOS message
When you have an emergency, you can send an 
SOS message asking for help.

1. In Idle mode, press the Confirm key → 
Messages → SOS messages → Sending 
options.

2. Scroll left or right to On.

3. Scroll down and press the Confirm key to open 
the recipient list.

4. Press <Options> → Phonebook to open your 
contact list.

5. Scroll to a contact and press the Confirm key.

6. When you are finished selecting contacts, press 
<Done> to return to the recipient list.

7. Press <Options> → OK to save the recipients.

8. Scroll down and set the number of times to 
repeat the SOS message.

9. Press <Save> → <Yes>.
To send an SOS message, the keys must be 
locked. With the keys locked, press [ / ] four 
times.

Activate the mobile tracker
When someone inserts a new SIM or USIM card in 
your phone, the mobile tracker feature will 
automatically send the contact number to two 
recipients to help you locate and recover your 
phone.

Once you send an SOS message, all phone 
functions will be suspended until you press 
[ ].
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To activate the mobile tracker,

1. In Idle mode, press the Confirm key → Settings 
→ Security → Mobile tracker.

2. Enter your password and press <Confirm>.

3. Scroll left or right to On.

4. Scroll down and press the Confirm key to open 
the recipient list.

5. Press <Options> → Phonebook to open your 
contact list.

6. Scroll to a contact and press the Confirm key.

7. Select a number.

8. Press <Options> → OK to save the recipients.

9. Scroll down and enter the sender’s name.

10.Press <Options> → Save → <Accept>.

Record and play voice memos
Learn to operate your phone’s voice recorder.

Record a voice memo
1. In Idle mode, press the Confirm key → 

Applications → Voice recorder.

2. Press the Confirm key to start recording.

3. Speak your memo into the microphone.

4. When you are finished speaking, press the 
navigation key down.

Play a voice memo
1. From the voice recorder screen, press 

<Options> → My voice clips.

2. Select a file.
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3. Control the playback using the following keys:

Use Java-powered games and 
applications
Learn to use games and applications powered by 
award-winning Java technology.

Play games
1. In Idle mode, press the Confirm key → My files or 

Entertainment → Games and more.

2. Select a game from the list and follow the 
onscreen instructions.

Launch applications
1. In Idle mode, press the Confirm key → My files or 

Entertainment → Games and more → an 
application.

2. Press <Options> to access a list of various 
options and settings for your application. 

Key Function

Confirm Pause or resume playback

Volume Adjust the volume up or down

Navigation
• Left: Scan backward in a file
• Right: Scan forward in a file
• Down: Stop playback

Available games may vary, depending on your 
service provider or region. Game controls and 
options may vary.
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Use the RSS reader
Learn to use the RSS reader to get the latest news 
and information from your favourite websites.

Create feeds
1. In Idle mode, press the Confirm key → 

Applications → RSS reader.

2. Press <Options> → Add.

3. Enter the address of an RSS feed and press 
<OK>.

4. To add more feeds, repeat steps 2-3 above.

Read RSS feeds
1. In Idle mode, press the Confirm key → 

Applications → RSS reader.

2. Press <Options> → Update → Selected or All 
to get the latest contents. 

3. Select a feed → an updated post.

Download multimedia
1. In Idle mode, press the Confirm key → 

Applications → RSS reader.

2. Scroll to a feed and press <Options> → Open.

3. Scroll to a post containing multimedia.

4. Press <Options> → Media → Download.

Customise RSS reader settings
1. In Idle mode, press the Confirm key → 

Applications → RSS reader.

2. Press <Options> → Setting.

3. Customise the settings as desired.
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Create and view world clocks
Learn to view the time in another country or city and 
set world clocks to appear on your display.

Create a world clock
1. In Idle mode, press the Confirm key → 

Applications → World clock.

2. Press <Options> → Add.

3. Scroll left or right to a time zone.

4. To set daylight saving time, scroll down and 
press the Confirm key.

5. Press <OK> to save your world clock.

6. To add more world clocks, repeat steps 2-5 
above.

Add a world clock to your display
In Dual Clock Display mode, you can view clocks 
with two different time zones on your display.

After you have saved world clocks,

1. In Idle mode, press the Confirm key → 
Applications → World clock.

2. Scroll to the world clock you want to add and 
press <Options> → Display settings.

3. Scroll left or right to Dual.

4. Scroll down, and then scroll left or right to a dual 
clock style.

5. Press <Save>.
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Set and use alarms
Learn to set and control alarms for important events.

Set a new alarm
1. In Idle mode, press the Confirm key → Alarms.

2. Scroll to an empty alarm location and press the 
Confirm key.

3. Set alarm details.

4. Press <Options> → Save.

Stop an alarm
When the alarm sounds,

• Press the Confirm key to stop an alarm without 
snooze.

• Press <OK> or the Confirm key to stop an alarm 
with snooze, or press <Snooze> or any key to 
silence the alarm for the snooze period.

Deactivate an alarm
1. In Idle mode, press the Confirm key → Alarms.

2. Scroll to the alarm you want to deactivate and 
press the Confirm key.

3. Scroll down (if necessary).

4. Scroll left or right to Off.

5. Press the Confirm key.

The auto power-up feature sets the phone to 
automatically turn on and sound the alarm at 
the designated time if the phone is turned off.
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Use the pedometer
1. In Idle mode, press the Confirm key → 

Applications → Pedometer.

2. Enter user information and press <Save>.

3. Press the Confirm key to start the pedometer.

4. Press the Confirm key to stop the pedometer.

Use the compass
Learn to read the directions and altitudes.

1. In Idle mode, press the Confirm key → 
Applications → Compass.

2. If you use the compass for the first time, calibrate 
it by turning your phone over as shown on the 
screen.

3. To recalibrate the compass, press <Calibrate>.

To use the compass, hold the phone flat in your 
palm, parallel to the ground and read the direction.

• Remove any metal jewellery and avoid 
coming too close to metal objects or places 
that affect the compass magnet. This may 
affect the accuracy of the direction reading.

• The air pressure at sea level used to measure 
the altitude is based on absolute air pressure 
(a pressure of 1 atm is 1013.25 hPa)

• The altitude measured at the same location 
may vary due to air pressure.

• The region you are in or weather conditions 
may reduce the accuracy of the altimeter.

•  Do not use the altimeter in rapid altitude shift, 
such as skydiving and paragliding.
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Use the calculator
1. In Idle mode, press the Confirm key → 

Applications → Calculator.

2. Use the keys that correspond to the calculator 
display to perform basic mathematical 
operations.

Convert currencies or 
measurements
1. In Idle mode, press the Confirm key → 

Applications → Convertor → a conversion type.

2. Enter the currencies or measurements and units 
in the appropriate fields.

Set a countdown timer
1. In Idle mode, press the Confirm key → 

Applications → Timer.

2. Press <Set>.

3. Enter hours or minutes to count down and press 
<OK>.

• THE COMPASS AND ALTIMETER PROVIDE 
GENERAL MEASUREMENTS FOR 
PERSONAL USE. AVOID USING THEM FOR 
ANY PURPOSE THAT IS PROHIBITED. 
INAPPROPRIATE USE MAY CAUSE 
DAMAGE OR DANGEROUS SITUATIONS 
THAT YOUR MANUFACTURER WILL NOT 
BE RESPONSIBLE FOR.
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4. Press the Confirm key to begin or pause the 

countdown.

5. When the timer expires, press <OK> to stop the 
alert.

Use the stopwatch
1. In Idle mode, press the Confirm key → 

Applications → Stopwatch.

2. Press the Confirm key to begin and record lap 
times.

3. When you are finished, press <Stop>.

4. Press <Reset> to clear recorded times.

Create a new task
1. In Idle mode, press the Confirm key → 

Applications → Task.

2. Press <Options> → Create.

3. Enter the details of the task.

4. Press <Options> → Save.

Create a text memo
1. In Idle mode, press the Confirm key → 

Applications → Memo.

2. Press <Options> → Create.

3. Enter your memo text and press the Confirm key.
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Manage your calendar
Learn to change the calendar view and create 
events.

Change the calendar view
1. In Idle mode, press the Confirm key → Calendar.

2. Press <Options> → View by → Day or Week.

Create an event
1. In Idle mode, press the Confirm key → Calendar.

2. Press <Options> → Create → an event type.

3. Enter the details of the event as required and 
press the Confirm key.
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troubleshooting
If you are having trouble with your mobile phone, try these troubleshooting procedures before contacting a service 
professional.

While you turn on your phone, the following 
messages may appear:

Message Try this to solve the problem:
Insert SIM 
card

Ensure that the SIM or USIM card is 
installed correctly.

Phone lock
When the phone lock feature is 
enabled, you must enter the 
password you set for the phone.

PIN lock

When using the phone for the first 
time or when the PIN requirement is 
enabled, you must enter the PIN 
supplied with the SIM or USIM card. 
You can disable this feature by using 
the PIN lock menu.

PUK lock

Your SIM or USIM card is blocked, 
usually as a result of entering your 
PIN incorrectly several times. You 
must enter the PUK supplied by your 
service provider. 

Message Try this to solve the problem:
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Your phone displays “No service” or “Service 
unavailable.”

• When you are in areas with weak signals or poor 
reception, you may lose reception. Move to 
another area and try again.

• You cannot access some options without a 
subscription. Contact your service provider for 
more details.

You enter a number, but the call is not dialled.

• Ensure that you have pressed the Dial key: [ ].
• Ensure that you have accessed the right cellular 

network.
• Ensure that you have not set call barring for the 

phone number.

Another caller cannot reach you.

• Ensure that your phone is turned on.
• Ensure that you have accessed the right cellular 

network.
• Ensure that you have not set call barring for the 

phone number.

Another caller cannot hear you speaking.

• Ensure that you are not covering the built-in 
microphone.

• Ensure that the microphone is close to your 
mouth.

• If using a headset, ensure that it is properly 
connected.
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The phone beeps and the battery icon flashes.

Your battery is low. Recharge or replace the battery to 
continue using the phone.

The audio quality of the call is poor.

• Ensure that you are not blocking the phone’s 
internal antenna.

• When you are in areas with weak signals or poor 
reception, you may lose reception. Move to 
another area and try again.

You select a contact to call, but the call is not 
dialled.

• Ensure that the correct number is stored in the 
contact list.

• Re-enter and save the number, if necessary.

The battery does not charge properly or 
sometimes the phone turns itself off.

• The battery terminals may be dirty. Wipe both 
gold-coloured contacts with a clean, soft cloth 
and try charging the battery again.

• If the battery will no longer charge completely, 
dispose of the old battery properly and replace it 
with a new battery.

Your phone is hot to the touch.

When you use several applications at once, your 
phone requires more power and may heat up.

This is normal and should not affect your phone’s 
lifespan or performance.
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Health and safety information
Exposure to Radio Frequency (RF) Signals

Your wireless phone is a radio transmitter and receiver. 
It is designed and manufactured not to exceed the 
emission limits for exposure to radio frequency (RF) 
energy set by the Federal Communications 
Commission (FCC) of the U.S. Government. These 
limits are part of comprehensive guidelines and 
establish permitted levels of RF energy for the general 
population. The guidelines are based on the safety 
standards that were developed by independent 
scientific organizations through periodic and through 
evaluation of scientific studies.

The standards include a substantial safety margin 
designed to assure the safety of all persons, 
regardless of age and health.

The exposure standard for wireless phones employs a 
unit of measurement known as Specific Absorption 
Rate (SAR). The SAR limit recommended by the FCC is 
1.6W/kg.*
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SAR tests are conducted using standard operating 
positions specified by the FCC with the phone 
transmitting at its highest certified power level in all 
tested frequency bands. 

Although the SAR is determined at the highest 
certified power level, the actual SAR level of the phone 
while operating can be well below the maximum value. 
This is because the phone is designed to operate at 
multiple power levels so as to use only the power 
required to reach the network. In general, the closer 
you are to a wireless base station antenna, the lower 
the power output of the phone.

Before a new model phone is available for sale to the 
public, it must be tested and certified to the FCC that 
it does not exceed the limit established by the 
government adopted requirement for safe exposure. 

The tests are performed in positions and locations 
(e.g., at the ear and worn on the body) as required by 
the FCC for each model. While there may be 
differences between the SAR levels of various phones 
and at various positions, they all meet the government 
requirement.

The FCC has granted an Equipment Authorization for 
this model phone with all reported SAR levels 
evaluated as in compliance with the FCC RF exposure 
guidelines. SAR information on this model phone is on 
file with the FCC and can be found under the Display 
Grant section of http://www.fcc.gov/oet/fccid after 
searching on FCC ID printed in the label on the phone.

*  In the U.S. and Canada, the SAR limit for mobile phones 
used by the public is 1.6 watts/kg (W/kg) averaged 
over one gram of tissue. The standard incorporates a 
substantial margin of safety to give additional 
protection for the public and to account for any 
variations in measurements.

R400.book  Page 17  Friday, January 11, 2008  9:45 AM



Health and safety information

For body operation

For body worn operation, this model phone has been 
tested and meets the FCC RF exposure guidelines 
when used with a Samsung-supplied or approved 
accessory designated for this product or when used 
with and accessory that contains no metal and that 
positions the handset a minimum from the body.

The minimum distance for this model phone is written 
in the FCC certification information from the body. 
None compliance with the above conditions may 
violate FCC RF exposure guidelines.

For more Information concerning exposure to radio 
frequency signals, see the following websites:

Federal Communications Commission (FCC)
http://www.fcc.gov

Cellular Telecommunications Industry Association 
(CTIA):
http://www.wow-com.com

U.S.Food and Drug Administration (FDA)
http://www.fda.gov/cdrh/consumer

World Health Organization (WHO)
http://www.who.int/peh-emf/en

Precautions when using batteries
• Never use any charger or battery that is damaged 

in any way.
• Use the battery only for its intended purpose.
• If you use the phone near the network’s base 

station, it uses less power; talk and standby time 
are greatly affected by the signal strength on the 
cellular network and the parameters set by the 
network operator. 

• Battery charging time depends on the remaining 
battery charge, the type of battery and the charger 
used. The battery can be charged and discharged 
hundreds of times, but it will gradually wear out. 
When the operation time (talk time and standby 
time) is noticeably shorter than normal, it is time 
to buy a new battery.

• If left unused, a fully charged battery will 
discharge itself over time.
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• Use only Samsung-approved batteries and 
recharge your battery only with Samsung-
approved chargers. When a charger is not in use, 
disconnect it from the power source. Do not leave 
the battery connected to a charger for more than a 
week, since overcharging may shorten its life.

• Extreme temperatures will affect the charging 
capacity of your battery: it may require cooling or 
warming first.

• Do not leave the battery in hot or cold places, such 
as in a car in summer or winter conditions, as you 
will reduce the capacity and lifetime of the battery. 
Always try to keep the battery at room 
temperature. A phone with a hot or cold battery 
may temporarily not work, even when the battery 
is fully charged. Li-ion batteries are particularly 
affected by temperatures below 0 °C (32 °F).

• Do not short-circuit the battery. Accidental short-
circuiting can occur when a metallic object (coin, 
clip or pen) causes a direct connection between the 
+ and – terminals of the battery (metal strips on 
the battery), for example when you carry a spare 
battery in a pocket or bag. Short-circuiting the 

terminals may damage the battery or the object 
causing the short-circuiting.

• Dispose used batteries in accordance with local 
regulations. Always recycle. Do not dispose 
batteries in a fire.

Road safety

Your wireless phone gives you the powerful ability to 
communicate by voice, almost anywhere, anytime. 
But an important responsibility accompanies the 
benefits of wireless phones, one that every user must 
uphold.

When driving a car, driving is your first responsibility. 
When using your wireless phone behind the wheel of a 
car, practice good common sense and remember the 
following tips:
• Get to know your wireless phone and its features, 

such as speed dial and redial. If available, these 
features help you to place your call without taking 
your attention off the road.

• When available, use a hands-free device. If 
possible, add an extra layer of convenience and 
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safety to your wireless phone with one of the many 
hands-free accessories available today.

• Position your wireless phone within easy reach. Be 
able to access your wireless phone without 
removing your eyes from the road. If you get an 
incoming call at an inconvenient time, let your 
voice mail answer it for you.

• Let the person you are speaking with know you are 
driving; if necessary, suspend the call in heavy 
traffic or hazardous weather conditions. Rain, 
sleet, snow, ice, and even heavy traffic can be 
hazardous.

• Do not take notes or look up phone numbers while 
driving. Jotting down a To Do list or flipping 
through your Address Book takes your attention 
away from your primary responsibility, driving 
safely.

• Dial sensibly and assess the traffic; if possible, 
place calls when you are not moving or before 
pulling into traffic. Try to plan calls when your car 
will be stationary. If you need to make a call while 
moving, dial only a few numbers, check the road 
and your mirrors, then continue.

• Do not engage in stressful or emotional 
conversations that may be distracting. Make the 
people with whom you are talking aware that you 
are driving and suspend conversations that have 
the potential to divert your attention from the 
road.

• Use your wireless phone to call for help. Dial the 
emergency number in the case of fire, traffic 
accident or medical emergencies. Remember, it is 
a free call on your wireless phone!

• Use your wireless phone to help others in 
emergencies. If you see a car accident, crime in 
progress or other serious emergency where lives 
are in danger, call the emergency number, as you 
would want others to do for you.
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• If you see a broken-down vehicle posing no serious 
hazard, a broken traffic signal, a minor traffic 
accident where no one appears injured, or a 
vehicle you know to be stolen, call roadside 
assistance or any other special non-emergency 
wireless number.

Operating environment

Remember to follow any special regulations in force in 
any area and always switch off your phone whenever it 
is forbidden to use it, or when it may cause 
interference or danger.

When connecting the phone or any accessory to 
another device, read its user’s guide for detailed 
safety instructions. Do not connect incompatible 
products.

As with other mobile radio transmitting equipment, 
users are advised that for the satisfactory operation of 
the equipment and for the safety of personnel, it is 
recommended that the equipment should only be used 
in the normal operating position (held to your ear with 
the antenna pointing over your shoulder).

Electronic devices

Most modern electronic equipment is shielded from 
radio frequency (RF) signals. However, certain 
electronic equipment may not be shielded against the 
RF signals from your wireless phone. Consult the 
manufacturer to discuss alternatives.

Pacemakers
Pacemaker manufacturers recommend that a 
minimum distance of 15 cm (6 inches) be maintained 
between a wireless phone and a pacemaker to avoid 
potential interference with the pacemaker. These 
recommendations are consistent with the independent 
research and recommendations of Wireless Technology 
Research.

Persons with pacemakers:
• should always keep the phone more than 15 cm (6 

inches) from their pacemaker when the phone is 
switched on.

• should not carry the phone in a breast pocket.
• should use the ear opposite the pacemaker to 

minimize potential interference.
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If you have any reason to suspect that interference is 
taking place, switch off your phone immediately.

Hearing aids
Some digital wireless phones may interfere with some 
hearing aids. In the event of such interference, you 
may wish to consult your hearing aid manufacturer to 
discuss alternatives.

Other medical devices
If you use any other personal medical devices, consult 
the manufacturer of your device to determine if it is 
adequately shielded from external RF energy. Your 
physician may be able to assist you in obtaining this 
information. Switch off your phone in health care 
facilities when any regulations posted in these areas 
instruct you to do so. Hospitals or health care facilities 
may be using equipment that could be sensitive to 
external RF energy.

Vehicles
RF signals may affect improperly installed or 
inadequately shielded electronic systems in motor 
vehicles. Check with the manufacturer or its 
representative regarding your vehicle. You should also 
consult the manufacturer of any equipment that has 
been added to your vehicle. You should also consult 
the manufacturer of any equipment that has been 
added to your vehicle.

Posted facilities
Switch off your phone in any facility where posted 
notices require you to do so.
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Potentially explosive environments

Switch off your phone when in any area with a 
potentially explosive atmosphere and obey all signs 
and instructions. Sparks in such areas could cause an 
explosion or fire resulting in bodily injury or even 
death.

Users are advised to switch off the phone while at a 
refueling point (service station). Users are reminded of 
the need to observe restrictions on the use of radio 
equipment in fuel depots (fuel storage and distribution 
areas), chemical plants or where blasting operations 
are in progress.

Areas with a potentially explosive atmosphere are 
often but not always clearly marked. They include the 
areas below deck on boats, chemical transfer or 
storage facilities, vehicles using liquefied petroleum 
gas (such as propane or butane), areas where the air 
contains chemicals or particles, such as grain, dust or 
metal powders, and any other area where you would 
normally be advised to turn off your vehicle engine.

Emergency calls

This phone, like any wireless phone, operates using 
radio signals, wireless and landline networks as well as 
user-programmed functions, which cannot guarantee 
connection in all conditions. Therefore, you should 
never rely solely on any wireless phone for essential 
communications (medical emergencies, for example).

Remember, to make or receive any calls the phone 
must be switched on and in a service area with 
adequate signal strength. Emergency calls may not be 
possible on all wireless phone networks or when 
certain network services and/or phone features are in 
use. Check with local service providers.

To make an emergency call:

If the phone is not on, switch it on.
1. Key in the emergency number for your present 

location (for example, 911 or other official 
emergency number). Emergency numbers vary by 
location.

2. Press [ ].
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If certain features are in use (call barring, for 
example), you may first need to deactivate those 
features before you can make an emergency call. 
Consult this document and your local cellular service 
provider.

When making an emergency call, remember to give all 
the necessary information as accurately as possible. 
Remember that your phone may be the only means of 
communication at the scene of an accident; do not end 
the call until given permission to do so.

Other important safety information
• Only qualified personnel should service the phone 

or install the phone in a vehicle. Faulty installation 
or service may be dangerous and may invalidate 
any warranty applicable to the device.

• Check regularly that all wireless phone equipment 
in your vehicle is mounted and operating properly.

• Do not store or carry flammable liquids, gases, or 
explosive materials in the same compartment as 
the phone, its parts or accessories.

• For vehicles equipped with an air bag, remember 
that an air bag inflates with great force. Do not 
place objects, including both installed or portable 
wireless equipment in the area over the air bag or 
in the air bag deployment area. If wireless 
equipment is improperly installed and the air bag 
inflates, serious injury could result.

• Switch off your phone before boarding an aircraft. 
The use of wireless phones in aircraft is illegal and 
may be dangerous to the aircraft’s operation.

• Failure to observe these instructions may lead to 
the suspension or denial of telephone services to 
the offender, or legal action, or both.

Care and maintenance

Your phone is a product of superior design and 
craftsmanship and should be treated with care. The 
suggestions below will help you fulfill any warranty 
obligations and allow you to enjoy this product for 
many years:
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• Keep the phone and all its parts and accessories 
out of the reach of small children’s.

• Keep the phone dry. Precipitation, humidity and 
liquids contain minerals that will corrode electronic 
circuits.

• Do not use the phone with a wet hand. Doing so 
may cause an electric shock to you or damage to 
the phone.

• Do not use or store the phone in dusty, dirty areas, 
as its moving parts may be damaged.

• Do not store the phone in hot areas. High 
temperatures can shorten the life of electronic 
devices, damage batteries, and warp or melt 
certain plastics.

• Do not store the phone in cold areas. When the 
phone warms up to its normal operating 
temperature, moisture can form inside the phone, 
which may damage the phone’s electronic circuit 
boards.

• Do not drop, knock or shake the phone. Rough 
handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents or 
strong detergents to clean the phone. Wipe it with 
a soft cloth slightly dampened in a mild soap-and-
water solution.

• Do not paint the phone. Paint can clog the device’s 
moving parts and prevent proper operation.

• Do not put the phone in or on heating devices, 
such as a microwave oven, a stove or a radiator. 
The phone may explode when overheated.

• Use only the supplied or an approved replacement 
antenna. Unauthorized antennas or modified 
accessories may damage the phone and violate 
regulations governing radio devices.

• If the phone, battery, charger or any accessory is 
not working properly, take it to your nearest 
qualified service facility. The personnel there will 
assist you, and if necessary, arrange for service.
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Acknowledging Special Precautions 
and the FCC and Industry Canada 
Notice

FCC Notice
• This device complies with Part 15 of FCC Rules. 

Operation is subject to the following two 
conditions: (1)This device may not cause harmful 
interference, and (2)This device must accept any 
interference received,including interference that 
may cause undesired operation.

• This equipment has been tested and found to 
comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection 
against harmful interference in a residential 
installation. This equipment generates, uses and 
can radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference to 
radio communications. However, there is no 
guarantee that interference will not occur in a 
particular installation. If this equipment does cause 
harmful interference to radio or television 

reception, which can be determined by turning the 
equipment off and on, the user is encouraged to 
try to correct the interference by one or more of 
the following measures:

     - Reorient or relocate the receiving antenna.

     - Increase the separation between the equipment  

       and receiver.

     - Connect the equipment into an outlet on a circuit 

       different from that to which the receiver is  

       connected.

     - Consult the dealer or an experienced radio/ TV 

        technician for help.

The phone may cause TV or radio interference if used 
in close proximity to receiving equipment. The FCC 
can require you to stop using the phone if such 
interference cannot be eliminated. Vehicles using 
liquefied petroleum gas (such as propane or butane) 
must comply with the National Fire Protection 
Standard (NFPA-58). For a copy of this standard, 
contact the National Fire Protection Association, One 
Battery march Park, Quincy, MA 02269, Attn: 
Publication Sales Division.
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Cautions
Changes or modifications made in the radio phone, not 
expressly approved by Samsung, will void the user’s 
authority to operate the equipment.

Only use approved batteries, antennas and chargers. 
The use of any unauthorized accessories may be 
dangerous and void the phone warranty if said 
accessories cause damage or a defect to the phone.

Although your phone is quite sturdy, it is a complex 
piece of equipment and can be broken. Avoid 
dropping, hitting, bending or sitting on it.

Appendix A: CERTIFICATION 
INFORMATION (SAR)
THIS MODEL PHONE MEETS THE GOVERNMENT’S 
REQUIREMENTS FOR EXPOSURE TO RADIO WAVES.

Your wireless phone is a radio transmitter and receiver. 
It is designed and manufactured not to exceed the 
emission limits for exposure to radio frequency (RF) 
energy set by the Federal Communications 
Commission of the U.S. Government. These limits are 
part of comprehensive guidelines and establish 
permitted levels of RF energy for the general 
population. The guidelines are based on safety 
standards that were developed by independent 
scientific organizations through periodic and thorough 
evaluation of scientific studies. The standards include 
a substantial safety margin designed to assure the 
safety of all persons, regardless of age and health.

The exposure standard for wireless mobile phones 
employs a unit of measurement known as the Specific 
Absorption Rate (SAR). The SAR limit set by the FCC is 
1.6 W/kg. SAR Tests are conducted using standard 
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operating positions accepted by the FCC with the 
phone transmitting at its highest certified power level 
in all tested frequency bands. Although the SAR is 
determined at the highest certified power level, the 
actual SAR level of the phone while operating can be 
well below the maximum value. This is because the 
phone is designed to operate at multiple power levels 
so as to use only the power required to reach the 
network. In general, the closer you are to a wireless 
base station antenna, the lower the power output.

Before a new model phone is available for sale to the 
public, it must be tested and certified to the FCC that 
it does not exceed the limit established by the 
government adopted requirement for safe exposure. 
The tests are performed in positions and 
locations(e.g., at the ear and worn on the body) as 
required by the FCC for each model.

The highest SAR values of this model phone as 
reported to FCC are,  
 

[GSM850] Head Max:0.389 W/Kg, Body Max: 0.638 W/Kg, 
[GSM1900] Head Max: 0.882 W/Kg, Body Max: 0.569 W/Kg, 
  

 
 
 
Body-worn operations are restricted to Samsung-
supplied, approved or none Samsung designated 
accessories that have no metal and must provide at 
least 1.5cm separation between the device, including 
its antenna whether extended or retracted, and the 
user’s body. None compliance to the above restrictions 
may violate FCC RF exposure guidelines.

The FCC has granted an Equipment Authorization for 
this model phone with all reported SAR levels 
evaluated as in compliance with the FCC RF exposure 
guidelines. SAR information on this model phone is on 
file with the FCC and can be found under the Display 
Grant section of http://www.fcc.gov/oet/fccid after 
searching on FCC ID A3LSWDB2703.*
 
 
 
*In the United States and Canada, the SAR limit for mobile
phones used by the public is 1.6 watts/kilogram (W/kg) aver-
aged over one gram of tissue. The standard incorporates a sub-
stantial ma gin of safety togive additional protection for the
public and to account for any variations in measurements.
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Appendix B: Guide to Safe and 
Responsible Wireless Phone Use
Cellular Telecommunications & Internet Association 
“Safety is the most important call you will ever make.”

A Guide to Safe and Responsible Wireless 
Phone Use
TENS OF MILLIONS OF PEOPLE IN THE U.S. TODAY 
TAKE ADVANTAGE OF THE UNIQUE COMBINATION OF 
CONVENIENCE, SAFETY AND VALUE DELIVERED BY 
THE WIRELESS TELEPHONE. QUITE SIMPLY, THE 
WIRELESS PHONE GIVES PEOPLE THE POWERFUL 
ABILITY TO COMMUNICATE BY VOICE-ALMOST 
ANYWHERE, ANYTIME-WITH THE BOSS, WITH A 
CLIENT, WITH THE KIDS, WITH EMERGENCY 
PERSONNEL OR EVEN WITH THE POLICE. EACH YEAR, 
AMERICANS MAKE BILLIONS OF CALLS FROM THEIR 
WIRELESS PHONES, AND THE NUMBERS ARE RAPIDLY 
GROWING.

But an important responsibility accompanies those 
benefits, one that every wireless phone user must 
uphold. When driving a car, driving is your first 

responsibility. A wireless phone can be an invaluable 
tool, but good judgment must be exercised at all times 
while driving a motor vehicle whether on the phone or 
not.

The basic lessons are ones we all learned as 
teenagers. Driving requires alertness, caution and 
courtesy. It requires a heavy dose of basic common 
sense-keep your head up, keep your eyes on the road, 
check your mirrors frequently and watch out for other 
drivers. 
It requires obeying all traffic signs and signals and 
staying within the speed limit. It means using seat 
belts and requiring other passengers to do the same. 

But with wireless phone use, driving safely means a 
little more. This brochure is a call to wireless phone 
users everywhere to make safety their first priority 
when behind the wheel of a car. Wireless 
telecommunications is keeping us in touch, simplifying 
our lives, protecting us in emergencies and providing 
opportunities to help others in need. When it comes to 
the use of wireless phones, safety is your most 
important call.

R400.book  Page 29  Friday, January 11, 2008  9:45 AM



Health and safety information

Wireless Phone “Safety Tips”
Below are safety tips to follow while driving and using 
a wireless phone which should be easy to remember:
1. Get to know your wireless phone and its features 

such as speed dial and redial. Carefully read your 
instruction manual and learn to take advantage of 
valuable features most phones offer, including 
automatic redial and memory. Also, work to 
memorize the phone keypad so you can use the 
speed dial function without taking your attention 
off the road.

2. When available, use a hands free device. A number 
of hands free wireless phone accessories are 
readily available today. Whether you choose an 
installed mounted device for your wireless phone 
or a speaker phone accessory, take advantage of 
these devices if available to you.

3. Position your wireless phone within easy reach. 
Make sure you place your wireless phone within 
easy reach and where you can grab it without 
removing your eyes from the road. If you get an 
incoming call at an inconvenient time, if possible, 
let your voice mail answer it for you.

4. Suspend conversations during hazardous driving 
conditions or situations. Let the person you are 
speaking with know you are driving; if necessary, 
suspend the call in heavy traffic or hazardous 
weather conditions. Rain, sleet, snow and ice can 
be hazardous, but so is heavy traffic. As a driver, 
your first responsibility is to pay attention to the 
road.

5. Do not take notes or look up phone numbers while 
driving. If you are reading an address book or 
business card, or writing a “to do” list while driving 
a car, you are not watching where you are going. 
It’s common sense. Don’t get caught in a 
dangerous situation because you are reading or 
writing and not paying attention to the road or 
nearby vehicles.
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6. Dial sensibly and assess the traffic; if possible, 
place calls when you are not moving or before 
pulling into traffic. Try to plan your calls before you 
begin your trip or attempt to coincide your calls 
with times you may be stopped at a stop sign, red 
light or otherwise stationary. But if you need to dial 
while driving, follow this simple tip-dial only a few 
numbers, check the road and your mirrors, then 
continue.

7. Do not engage in stressful or emotional 
conversations that may be distracting. Stressful or 
emotional conversations and driving do not mix-
they are distracting and even dangerous when you 
are behind the wheel of a car. Make people you are 
talking with aware you are driving and if 
necessary, suspend conversations which have the 
potential to divert your attention from the road.

8. Use your wireless phone to call for help. Your 
wireless phone is one of the greatest tools you can 
own to protect yourself and your family in 
dangerous situations-with your phone at your side, 
help is only three numbers away. Dial 9-1-1 or 

other local emergency number in the case of fire, 
traffic accident, road hazard or medical 
emergency. Remember, it is a free call on your 
wireless phone!

9. Use your wireless phone to help others in 
emergencies. Your wireless phone provides you a 
perfect opportunity to be a “Good Samaritan” in 
your community. If you see an auto accident, 
crime in progress or other serious emergency 
where lives are in danger, call 9-1-1 or other local 
emergency number, as you would want others to 
do for you.

10. Call roadside assistance or a special wireless non 
emergency assistance number when necessary. 
Certain situations you encounter while driving may 
require attention, but are not urgent enough to 
merit a call for emergency services. But you still 
can use your wireless phone to lend a hand. If you 
see a broken-down vehicle posing no serious 
hazard, a broken traffic signal, a minor traffic 
accident where no one appears injured or a vehicle 
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you know to be stolen, call roadside assistance or 
other special non-emergency wireless number.

Careless, distracted individuals and people driving 
irresponsibly represent a hazard to everyone on the 
road. Since 1984, the Cellular Telecommunications 
Industry Association and the wireless industry have 
conducted educational outreach to inform wireless 
phone users of their responsibilities as safe drivers 
and good citizens. As we approach a new century, 
more and more of us will take advantage of the 
benefits of wireless telephones. 
And, as we take to the roads, we all have a 
responsibility to drive safely.

“The wireless industry reminds you to use your phone 
safely when driving.”

Cellular Telecommunications & Internet Association 
For more information, please call 1-888-901-SAFE. 
For updates: http://www.wow-com.com/consumer/
issues/driving/articles.cfm?ID =85

Appendix C: Consumer Update on 
Wireless Phones
U.S. Food and Drug Administration
1. What kinds of phones are the subject of this 

update?

The term wireless phone refers here to hand-held 
wireless phones with built-in antennas, often called 
cell, mobile, or PCS phones. These types of wireless 
phones can expose the user to measurable radio 
frequency energy (RF) because of the short distance 
between the phone and the user s head. These RF 
exposures are limited by Federal Communications 
Commission safety guidelines that were developed 
with the advice of FDA and other federal health and 
safety agencies. When the phone is located at greater 
distances from the user, the exposure to RF is 
drastically lower because a person’s RF exposure 
decreases rapidly with increasing distance from the 
source. The so-called “cordless phones,” which have a 
base unit connected to the telephone wiring in a 
house, typically operate at far lower power levels, and 
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thus produce RF exposures well within the FCC’s 
compliance limits.
2. Do wireless phones pose a health hazard?

The available scientific evidence does not show that 
any health problems are associated with using 
wireless phones. There is no proof, however, that 
wireless phones are absolutely safe. Wireless phones 
emit low levels of radio frequency energy (RF) in the 
microwave range while being used. They also emit 
very low levels of RF when in the stand-by mode. 
Whereas high levels of RF can produce health effects 
(by heating tissue), exposure to low level RF that does 
not produce heating effects causes no known adverse 
health effects. Many studies of low level RF exposures 
have not found any biological effects. Some studies 
have suggested that some biological effects may 
occur, but such findings have not been confirmed by 
additional research. In some cases, other researchers 
have had difficulty in reproducing those studies, or in 
determining the reasons for inconsistent results.

3. What is FDA’s role concerning the safety of wireless 
phones?

Under the law, FDA does not review the safety of 
radiation emitting consumer products such as wireless 
phones before they can be sold, as it does with new 
drugs or medical devices. However, the agency has 
authority to take action if wireless phones are shown 
to emit radio frequency energy (RF) at a level that is 
hazardous to the user. In such a case, FDA could 
require the manufacturers of wireless phones to notify 
users of the health hazard and to repair, replace or 
recall the phones so that the hazard no longer exists.

Although the existing scientific data do not justify FDA 
regulatory actions, FDA has urged the wireless phone 
industry to take a number of steps, including the 
following:
• Support needed research into possible biological 

effects of RF of the type emitted by wireless 
phones;
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• Design wireless phones in a way that minimizes 
any RF exposure to the user that is not necessary 
for device function; and

• Cooperate in providing users of wireless phones 
with the best possible information on possible 
effects of wireless phone use on human health

FDA belongs to an interagency working group of the 
federal agencies that have responsibility for different 
aspects of RF safety to ensure coordinated efforts at 
the federal level. The following agencies belong to this 
working group:
• National Institute for Occupational Safety and 

Health
• Environmental Protection Agency Federal 

Communications Commission
• Occupational Safety and Health Administration
• National Telecommunications and Information 

Administration
• The National Institutes of Health participates in 

some interagency working group activities, as well. 
FDA shares regulatory responsibilities for wireless 

phones with the Federal Communications 
Commission (FCC). All phones that are sold in the 
United States must comply with FCC safety 
guidelines that limit RF exposure. FCC relies on 
FDA and other health agencies for safety questions 
about wireless phones.

FCC also regulates the base stations that the wireless 
phone networks rely upon. While these base stations 
operate at higher power than do the wireless phones 
themselves, the RF exposures that people get from 
these base stations are typically thousands of times 
lower than those they can get from wireless phones. 
Base stations are thus not the primary subject of the 
safety questions discussed in this document.
4. What is FDA doing to find out more about the 

possible health effects of wireless phone RF?

FDA is working with the U.S. National Toxicology 
Program and with groups of investigators around the 
world to ensure that high priority animal studies are 
conducted to address important questions about the 
effects of exposure to radio frequency energy (RF).
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FDA has been a leading participant in the World Health 
Organization International Electromagnetic Fields 
(EMF) Project since its inception in 1996. An influential 
result of this work has been the development of a 
detailed agenda of research needs that has driven the 
establishment of new research programs around the 
world. The Project has also helped develop a series of 
public information documents on EMF issues.

FDA and the Cellular Telecommunications & Internet 
Association (CTIA) have a formal Cooperative 
Research and Development Agreement (CRADA) to do 
research on wireless phone safety. FDA provides the 
scientific oversight, obtaining input from experts in 
government, industry, and academic organizations. 
CTIA-funded research is conducted through contracts 
to independent investigators. The initial research will 
include both laboratory studies and studies of wireless 
phone users. The CRADA will also include a broad 
assessment of additional research needs in the 
context of the latest research developments around 
the world.

5. What steps can I take to reduce my exposure to 
radio frequency energy from my wireless phone?

If there is a risk from these products—and at this point 
we do not know that there is—it is probably very 
small. But if you are concerned about avoiding even 
potential risks, you can take a few simple steps to 
minimize your exposure to radio frequency energy 
(RF). Since time is a key factor in how much exposure 
a person receives, reducing the amount of time spent 
using a wireless phone will reduce RF exposure.

If you must conduct extended conversations by 
wireless phone every day, you could place more 
distance between your body and the source of the RF, 
since the exposure level drops off dramatically with 
distance. For example, you could use a headset and 
carry the wireless phone away from your body or use a 
wireless phone connected to a remote antenna

Again, the scientific data do not demonstrate that 
wireless phones are harmful. But if you are concerned 
about the RF exposure from these products, you can 
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use measures like those described above to reduce 
your RF exposure from wireless phone use.
6. What about children using wireless phones?

The scientific evidence does not show a danger to 
users of wireless phones, including children and 
teenagers. If you want to take steps to lower exposure 
to radio frequency energy (RF), the measures 
described above would apply to children and 
teenagers using wireless phones. Reducing the time of 
wireless phone use and increasing the distance 
between the user and the RF source will reduce RF 
exposure.

Some groups sponsored by other national 
governments have advised that children be 
discouraged from using wireless phones at all. For 
example, the government in the United Kingdom 
distributed leaflets containing such a recommendation 
in December 2000. They noted that no evidence exists 
that using a wireless phone causes brain tumors or 
other ill effects. Their recommendation to limit 
wireless phone use by children was strictly 

precautionary; it was not based on scientific evidence 
that any health hazard exists.
7. Do hands-free kits for wireless phones reduce risks 

from exposure to RF emissions?

Since there are no known risks from exposure to RF 
emissions from wireless phones, there is no reason to 
believe that hands-free kits reduce risks. Hands-free 
kits can be used with wireless phones for convenience 
and comfort. These systems reduce the absorption of 
RF energy in the head because the phone, which is the 
source of the RF emissions, will not be placed against 
the head. On the other hand, if the phone is mounted 
against the waist or other part of the body during use, 
then that part of the body will absorb more RF energy. 
Wireless phones marketed in the U.S. are required to 
meet safety requirements regardless of whether they 
are used against the head or against the body. Either 
configuration should result in compliance with the 
safety limit.
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8. Do wireless phone accessories that claim to shield 
the head from RF radiation work?

Since there are no known risks from exposure to RF 
emissions from wireless phones, there is no reason to 
believe that accessories that claim to shield the head 
from those emissions reduce risks. Some products 
that claim to shield the user from RF absorption use 
special phone cases, while others involve nothing 
more than a metallic accessory attached to the phone. 
Studies have shown that these products generally do 
not work as advertised. Unlike “hand-free” kits, these 
so-called “shields” may interfere with proper operation 
of the phone. The phone may be forced to boost its 
power to compensate, leading to an increase in RF 
absorption. In February 2002, the Federal trade 
Commission (FTC) charged two companies that sold 
devices that claimed to protect wireless phone users 
from radiation with making false and unsubstantiated 
claims. According to FTC, these defendants lacked a 
reasonable basis to substantiate their claim.
9. What about wireless phone interference with 

medical equipment?

Radio frequency energy (RF) from wireless phones can 
interact with some electronic devices. For this reason, 
FDA helped develop a detailed test method to measure 
electromagnetic interference (EMI) of implanted 
cardiac pacemakers and defibrillators from wireless 
telephones. This test method is now part of a standard 
sponsored by the Association for the Advancement of 
Medical instrumentation (AAMI). The final draft, a joint 
effort by FDA, medical device manufacturers, and 
many other groups, was completed in late 2000. This 
standard will allow manufacturers to ensure that 
cardiac pacemakers and defibrillators are safe from 
wireless phone EMI.

FDA has tested hearing aids for interference from 
handheld wireless phones and helped develop a 
voluntary standard sponsored by the Institute of 
Electrical and Electronic Engineers (IEEE). This 
standard specifies test methods and performance 
requirements for hearing aids and wireless phones so 
that no interference occurs when a person uses a 
compatible phone and a compatible hearing aid at the 

R400.book  Page 37  Friday, January 11, 2008  9:45 AM



Health and safety information

same time. This standard was approved by the IEEE in 
2000.

FDA continues to monitor the use of wireless phones 
for possible interactions with other medical devices. 
Should harmful interference be found to occur, FDA 
will conduct testing to assess the interference and 
work to resolve the problem.
10.What are the results of the research done already?

The research done thus far has produced conflicting 
results, and many studies have suffered from flaws in 
their research methods. Animal experiments 
investigating the effects of radio frequency energy 
(RF) exposures characteristic of wireless phones have 
yielded conflicting results that often cannot be 
repeated in other laboratories. A few animal studies, 
however, have suggested that low levels of RF could 
accelerate the development of cancer in laboratory 
animals. However, many of the studies that showed 
increased tumor development used animals that had 
been genetically engineered or treated with cancer 
causing chemicals so as to be pre-disposed to develop 
cancer in the absence of RF exposure. Other studies 

exposed the animals to RF for up to 22 hours per day. 
These conditions are not similar to the conditions 
under which people use wireless phones, so we don’t 
know with certainty what the results of such studies 
mean for human health.

Three large epidemiology studies have been published 
since December 2000. Between them, the studies 
investigated any possible association between the use 
of wireless phones and primary brain cancer, gioma, 
meningioma, or acoustic neuroma, tumors of the brain 
or salivary gland, leukemia, or other cancers. None of 
the studies demonstrated the existence of any harmful 
health effects from wireless phone RF exposures. 
However, none of the studies can answer questions 
about long-term exposures, since the average period 
of phone use in these studies was around three years.
11.What research is needed to decide whether RF 

exposure from wireless phones poses a health 
risk?

A combination of laboratory studies and 
epidemiological studies of people actually using 
wireless phones would provide some of the data that 
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are needed. Lifetime animal exposure studies could be 
completed in a few years. However, very large 
numbers of animals would be needed to provide 
reliable proof of a cancer promoting effect if one 
exists. Epidemiological studies can provide data that is 
directly applicable to human populations, but 10 or 
more years follow-up may be needed to provide 
answers about some health effects, such as cancer. 
This is because the interval between the time of 
exposure to a cancer-causing agent and the time 
tumors develop - if they do - may be many, many 
years. The interpretation of epidemiological studies is 
hampered by difficulties in measuring actual RF 
exposure during day-to-day use of wireless phones. 
Many factors affect this measurement, such as the 
angle at which the phone is held, or which model of 
phone is used.
12.Which other federal agencies have responsibilities 

related to potential RF health effects?

Additional information on the safety of RF exposures 
from various sources can be obtained from the 
following organizations.

FCC RF Safety Program:
http://www.fcc.gov/oet/rfsafety/

Environmental Protection Agency (EPA):
http://www.epa.gov/radiation/

Occupational Safety and Health Administration’s 
(OSHA):
http://www.osha-slc.gov/SLTC/
radiofrequencyradiation/index.html

National Institute for Occupational Safety and Health 
(NIOSH):
http://www.cdc.gov/niosh/emfpg.html

World health Organization (WHO):
http://www.who.int/peh-emf/

International Commission on Non-Ionizing Radiation 
Protection:
http://www.icnirp.de

National Radiation Protection Board (UK):
http://www.nrpb.org.uk

Updated 4/3/2002: US Food and Drug Administration 
http://www.fda.gov/cellphones
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